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Introduction

I’m very proud to present you with Excel 2013 For Dummies, the latest ver-
sion of everybody’s favorite book on Microsoft Office Excel for readers 

with no intention whatsoever of becoming spreadsheet gurus.

Excel 2013 For Dummies covers all the fundamental techniques you need 
to know in order to create, edit, format, and print your own worksheets. In 
addition to showing you around the worksheet, this book also exposes you 
to the basics of charting, creating data lists, and performing data analysis. 
Keep in mind, though, that this book just touches on the easiest ways to get a 
few things done with these features — I don’t attempt to cover charting, data 
lists, or data analysis in the same definitive way as spreadsheets: This book 
concentrates on spreadsheets because spreadsheets are what most regular 
folks create with Excel.

About This Book
This book isn’t meant to be read cover to cover. Although its chapters are 
loosely organized in a logical order (progressing as you might when study-
ing Excel in a classroom situation), each topic covered in a chapter is really 
meant to stand on its own.

Each discussion of a topic briefly addresses the question of what a particular 
feature is good for before launching into how to use it. In Excel, as with most 
other sophisticated programs, you usually have more than one way to do a 
task. For the sake of your sanity, I have purposely limited the choices by 
usually giving you only the most efficient ways to do a particular task. Later, 
if you’re so tempted, you can experiment with alternative ways of doing a 
task. For now, just concentrate on performing the task as I describe.

As much as possible, I’ve tried to make it unnecessary for you to remember 
anything covered in another section of the book. From time to time, however, 
you will come across a cross-reference to another section or chapter in the 
book. For the most part, such cross-references are meant to help you get 
more complete information on a subject, should you have the time and inter-
est. If you have neither, no problem. Just ignore the cross-references as if 
they never existed.



2 Excel 2013 For Dummies 

How to Use This Book
This book is similar to a reference book. You can start by looking up the 
topic you need information about (in either the Table of Contents or the 
index) and then refer directly to the section of interest. I explain most topics 
conversationally (as though you were sitting in the back of a classroom 
where you can safely nap). Sometimes, however, my regiment-commander 
mentality takes over, and I list the steps you need to take to accomplish a 
particular task in a particular section.

What You Can Safely Ignore
When you come across a section that contains the steps you take to get 
something done, you can safely ignore all text accompanying the steps (the 
text that isn’t in bold) if you have neither the time nor the inclination to wade 
through more material.

Whenever possible, I have also tried to separate background or footnote-
type information from the essential facts by exiling this kind of junk to a 
sidebar (look for blocks of text on a gray background). Often, these sections 
are flagged with icons that let you know what type of information you will 
encounter there. You can easily disregard text marked this way. (I’ll scoop 
you on the icons I use in this book a little later.)

Foolish Assumptions
I’m only going to make one foolish assumption about you and that is that 
you have some need to use Microsoft Excel 2013 in your work or studies. 
If pushed, I further guess that you aren’t particularly interested in knowing 
Excel at an expert level but are terribly motivated to find out how to do the 
stuff you need to get done. If that’s the case, this is definitely the book for 
you. Fortunately, even if you happen to be one of those newcomers who’s 
highly motivated to become the company’s resident spreadsheet guru, 
you’ve still come to the right place.

As far as your hardware and software goes, I’m assuming that you already 
have Excel 2013 (usually as part of Microsoft Office 2013) installed on your 
computing device, using a standard home or business installation running 
under either Windows 7 or 8. I’m not assuming, however, that when you’re 
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using Excel 2013 under Windows 7 or 8 that you’re sitting in front of a large-
screen monitor and making cell entries and command selections with a 
physical keyboard or connected mouse. With the introduction of Microsoft’s 
Surface tablet for Windows 8 and the support for a whole slew of different 
Windows tablets, you may well be entering data and selecting commands 
with your finger or stylus using the Windows Touch keyboard and Touch 
Pointer. 

 To deal with the differences between using Excel 2013 on a standard desktop 
or laptop computer with access only to a physical keyboard and mouse and a 
touchscreen tablet or smartphone environment with access only to the virtual 
Touch keyboard and Touch Pointer, I’ve outlined the touchscreen equivalents 
to common commands you find throughout the text such as “click,” “double-
click,” “drag,” and so forth in the section entitled, “Selecting commands by 
touch” in Chapter 1.

Keep in mind that although most of the figures in this book show Excel 2013 
happily running on Windows 7, you will see the occasional figure showing 
Excel running on Windows 8 in the rare cases (as when opening and saving 
files) where the operating system you’re using does make a difference.

 This book is intended only for users of Microsoft Excel 2013! Because of the 
diversity of the devices that Excel 2013 runs on and the places where its files 
can be saved and used, if you’re using Excel 2007 or Excel 2010 for Windows, 
much of the file-related information in this book may only confuse and con-
found you. If you’re still using a version prior to Excel 2007, which introduced 
the Ribbon interface, this edition will be of no use to you because your version 
of the program works nothing like the 2013 version this book describes.

How This Book Is Organized
This book is organized in six parts with each part containing two or more 
chapters (to keep the editors happy) that more or less go together (to keep 
you happy). Each chapter is divided further into loosely related sections that 
cover the basics of the topic at hand. However, don’t get hung up on follow-
ing the structure of the book; ultimately, it doesn’t matter whether you find 
out how to edit the worksheet before you learn how to format it, or whether 
you figure out printing before you learn editing. The important thing is that 
you find the information — and understand it when you find it — when you 
need to perform a particular task.

In case you’re interested, a synopsis of what you find in each part follows.
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Part I: Getting Started with Excel 2013
As the name implies, in this part I cover such fundamentals as how to start 
the program, identify the parts of the screen, enter information in the work-
sheet, save a document, and so on. If you’re starting with absolutely no 
background in using spreadsheets, you definitely want to glance at the infor-
mation in Chapter 1 to discover the secrets of the Ribbon interface before 
you move on to how to create new worksheets in Chapter 2.

Part II: Editing without Tears
In this part, I show you how to edit spreadsheets to make them look good, 
including how to make major editing changes without courting disaster. 
Peruse Chapter 3 when you need information on formatting the data to 
improve the way it appears in the worksheet. See Chapter 4 for rearranging, 
deleting, or inserting new information in the worksheet. Read Chapter 5 for 
the skinny on printing your finished product.

Part III: Getting Organized 
and Staying That Way
Here I give you all kinds of information on how to stay on top of the data that 
you’ve entered into your spreadsheets. Chapter 6 is full of good ideas on how 
to keep track of and organize the data in a single worksheet. Chapter 7 gives 
you the ins and outs of working with data in different worksheets in the same 
workbook and gives you information on transferring data between the sheets 
of different workbooks.

Part IV: Digging Data Analysis
This part consists of two chapters. Chapter 8 introduces performing vari-
ous types of what-if analysis in Excel, including setting up data tables with 
one and two inputs, performing goal seeking, and creating different cases 
with Scenario Manager. Chapter 9 introduces Excel’s vastly improved pivot 
table and pivot chart capabilities that enable you to summarize and filter 
vast amounts of data in a worksheet table or data list in a compact tabular or 
chart format.
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Part V: Life beyond the Spreadsheet
In Part V, I explore some of the other aspects of Excel besides the spread-
sheet. In Chapter 10, you find out just how ridiculously easy it is to create 
a chart using the data in a worksheet. In Chapter 11, you discover just how 
useful Excel’s data list capabilities can be when you have to track and orga-
nize a large amount of information. In Chapter 12, you find out about using 
add-in programs to enhance Excel’s basic features, adding hyperlinks to jump 
to new places in a worksheet, to new documents, and even to web pages, as 
well as how to record macros to automate your work.

Part VI: The Part of Tens
As is the tradition in For Dummies books, the last part contains lists of the 
top ten most useful and useless facts, tips, and suggestions. In this part, you 
find two chapters. Chapter 13 provides you with the top ten beginner basics 
you need to know as you start using this program. Chapter 14 gives you the 
King James Version of the Ten Commandments of Excel 2013. With this chap-
ter under your belt, how canst thou goest astray?

Conventions Used in This Book
The following information gives you the lowdown on how things look in this 
book. Publishers call these items the book’s conventions (no campaigning, 
flag-waving, name-calling, or finger-pointing is involved, however).

Selecting Ribbon commands
Throughout the book, you’ll find Ribbon command sequences (the name on 
the tab on the Ribbon and the command button you select) separated by a 
command arrow, as in:

HOME➪Copy

This shorthand is the Ribbon command that copies whatever cells or graph-
ics are currently selected to the Windows Clipboard. It means that you click 
the Home tab on the Ribbon (if it isn’t displayed already) and then click the 
Copy button (that sports the traditional side-by-side page icon).
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Some of the Ribbon command sequences involve not only selecting a com-
mand button on a tab, but then also selecting an item on a drop-down menu. 
In this case, the drop-down menu command follows the name of the tab and 
command button, all separated by command arrows, as in:

Formulas➪Calculation Options➪Manual

This shorthand is the Ribbon command sequence that turns on manual recal-
culation in Excel. It says that you click the Formulas tab (if it isn’t displayed 
already) and then click the Calculation Options button followed by the 
Manual drop-down menu option.

The book occasionally encourages you to type something specific into a 
specific cell in the worksheet. When I tell you to enter a specific function, 
the part you should type generally appears in bold type. For example, 
=SUM(A2:B2) means that you should type exactly what you see: an equal 
sign, the word SUM, a left parenthesis, the text A2:B2 (complete with a colon 
between the letter-number combos), and a right parenthesis. You then, of 
course, have to press Enter to make the entry stick.

Occasionally, I give you a hot key combination that you can press in order to 
choose a command from the keyboard rather than clicking buttons on the 
Ribbon with the mouse. Hot key combinations are written like this: Alt+FS or 
Ctrl+S (both of these hot key combos save workbook changes). 

With the Alt key combos on a physical keyboard, you press the Alt key until 
the hot key letters appear in little squares all along the Ribbon. At that point, 
you can release the Alt key and start typing the hot key letters (by the way, 
you type all lowercase hot key letters — I only put them in caps to make 
them stand out in the text).

Hot key combos that use the Ctrl key are of an older vintage and work a little 
bit differently. On physical keyboards you have to hold down the Ctrl key 
while you type the hot key letter (though again, type only lowercase letters 
unless you see the Shift key in the sequence, as in Ctrl+Shift+C).

Excel 2013 uses only one pull-down menu (File) and one toolbar (the Quick 
Access toolbar). You open the File pull-down menu by clicking the File button 
or pressing Alt+F to access the Excel Backstage view. The Quick Access tool-
bar with its four buttons appears directly above the File button.

Finally, if you’re really observant, you may notice a discrepancy in how the 
names of dialog box options (such as headings, option buttons, and check 
boxes) appear in the text and how they actually appear in Excel on your com-
puter screen. I intentionally use the convention of capitalizing the initial let-
ters of all the main words of a dialog box option to help you differentiate the 
name of the option from the rest of the text describing its use.
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Icons used in this book
The following icons are placed in the margins to point out stuff you may or 
may not want to read.

 This icon alerts you to nerdy discussions that you may well want to skip (or 
read when no one else is around).

 This icon denotes a tidbit only for Excel users who are running Excel 2013 on 
some sort of touchscreen device such as a Windows 8 tablet or smartphone.

 This icon alerts you to shortcuts or other valuable hints related to the topic 
at hand.

 This icon alerts you to information to keep in mind if you want to meet with a 
modicum of success.

 This icon alerts you to information to keep in mind if you want to avert 
complete disaster.

Where to Go from Here
If you’ve never worked with a computer spreadsheet, I suggest that you first 
go to Chapter 1 and find out what you’re dealing with. Then, as specific needs 
arise (such as, “How do I copy a formula?” or “How do I print just a particular 
section of my worksheet?”), you can go to the Table of Contents or the index 
to find the appropriate section and go right to that section for answers.

Occasionally, John Wiley & Sons, Inc., has updates to its technology books. If 
this book has technical updates, they will be posted at www.dummies.com/
go/excel2013updates.





Part I

 Visit www.dummies.com for more great Dummies content online.



In this part…
 ✓ Explore the Excel user Ribbon interface.

 ✓ Make sense of the most commonly used tabs and command 
buttons.

 ✓ Customize the Quick Access toolbar.

 ✓ Start (and stop) Excel 2013.

 ✓ Find help through the online Excel 2013 Help window.

 ✓ Become familiar with the prominent buttons and boxes for 
entering spreadsheet data.

 ✓ Recover a lost workbook when disaster strikes.

 ✓ Visit www.dummies.com for more great Dummies content 
online.



Chapter 1

The Excel 2013 User Experience
In This Chapter
▶ Getting familiar with the Excel 2013 program window and Backstage view

▶ Selecting commands from the Ribbon

▶ Customizing the Quick Access toolbar 

▶ Methods for starting Excel 2013

▶ Surfing an Excel 2013 worksheet and workbook

▶ Getting some help with using this program

Excel 2013, like Excel 2010 and Excel 2007 before it, relies upon a single 
strip at the top of the worksheet called the Ribbon that puts the bulk of 

the Excel commands you use at your fingertips at all times.

Add to the Ribbon a File tab and a Quick Access toolbar — along with a few 
remaining task panes (Clipboard, Clip Art, and Research) — and you end up 
with the handiest way to crunch your numbers, produce and print polished 
financial reports, as well as organize and chart your data. In other words, to 
do all the wonderful things for which you rely on Excel.

Best of all, the Excel 2013 user interface includes all sorts of graphical ele-
ments that make working on spreadsheets a lot faster and a great deal easier. 
Foremost is Live Preview that shows you how your actual worksheet data 
would appear in a particular font, table formatting, and so on before you 
actually select it. This Live Preview extends to the new Quick Analysis and 
Recommended PivotTables and Recommended Charts commands to enable 
you to preview your data in various formats before you apply them.

Additionally, Excel 2013 supports a Page Layout View that displays rulers 
and margins along with headers and footers for every worksheet with a Zoom 
slider at the bottom of the screen that enables you to zoom in and out on the 
spreadsheet data instantly. Finally, Excel 2013 is full of pop-up galleries that 
make spreadsheet formatting and charting a real breeze, especially in tandem 
with Live Preview.
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Excel’s Ribbon User Interface
When you launch Excel 2013, the Start screen similar to the one shown in 
Figure 1-1 opens. Here you can start a new blank workbook by clicking the 
Blank workbook template, or you can select any of the other templates 
shown as the basis for your new spreadsheet. If none of the templates shown 
in the Start screen suits your needs, you can search for templates online. 
After you’ve worked with Excel for some time, the Start screen also displays a 
list of recently opened workbooks that you can reopen for further editing or 
printing.

When you select the Blank workbook template from the Excel 2013 Start 
screen, the program opens an initial worksheet (named Sheet1) in a new 
workbook file (named Book1) inside a program window like the one shown in 
Figure 1-2.

 

Figure 1-1: 
The Excel 
2013 Start 

screen 
enables you 

to open a 
new blank 
workbook, 
a recently 

opened 
workbook, 

or find a 
template to 
use as the 

basis for 
a new 

workbook.
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Figure 1-2: 
The Excel 

2013 
program 

window that 
appears 
immedi-

ately after 
selecting 
the Blank 

Workbook 
template in 

the opening 
screen.

 

The Excel program window containing this worksheet of the workbook con-
tains the following components:

 ✓ File button that when clicked opens the Backstage view — a menu on 
the left that contains all the document- and file-related commands, 
including Info, New, Open (selected by default when you first launch 
Excel), Save, Save As, Print, Share, Export, and Close. Additionally, at the 
bottom, there’s an Account option with User and Product information 
and an Options item that enables you to change many of Excel’s default 
settings. Note that you can exit the Backstage view and return to the 
normal worksheet view.
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 ✓ Customizable Quick Access toolbar that contains buttons you can click 
to perform common tasks, such as saving your work and undoing and 
redoing edits. This toolbar is preceded by an Excel program button 
(sporting the Excel 2013 icon) with a drop-down menu of options that 
enable you to control the size and position of the Excel window and 
even close (exit) the program.

 ✓ Ribbon that contains the bulk of the Excel commands arranged into a 
series of tabs ranging from Home through View.

 ✓ Formula bar that displays the address of the current cell along with the 
contents of that cell.

 ✓ Worksheet area that contains the cells of the worksheet identified by 
column headings using letters along the top and row headings using 
numbers along the left edge; tabs for selecting new worksheets; a hori-
zontal scroll bar to move left and right through the sheet; and a vertical 
scroll bar to move up and down through the sheet.

 ✓ Status bar that keeps you informed of the program’s current mode and 
any special keys you engage and enables you to select a new worksheet 
view and to zoom in and out on the worksheet.

Going Backstage
To the immediate left of the Home tab on the Ribbon right below the Quick 
Access toolbar, you find the File button.

When you select File, the Backstage view opens. This view contains a menu 
similar to the one shown in Figure 1-3. When you open the Backstage view 
with the Info option selected, Excel displays at-a-glance stats about the work-
book file you have open and active in the program.

This information panel is divided into two panes. The pane on the left con-
tains large buttons that enable you to modify the workbook’s protection 
status, check the document before publishing, and manage its versions. The 
pane on the right contains a list of fields detailing the workbook’s various 
Document Properties, some of which you can change (such as Title, Tags, 
Categories, Author, and Last Modified By), and many of which you can’t 
(such as Size, Last Modified, Created, and so forth).

Below the Info option, you find the commands (New, Open, Save, Save As, 
Print, Share, Export, and Close) you commonly need for working with Excel 
workbook files. Near the bottom, the File tab contains an Account option 
that, when selected, displays an Account panel in the Backstage view. This 
panel displays user, connection, and Microsoft Office account information. 
Below the Account menu item, you find options that you can select to change 
the program’s settings.
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Figure 1-3: 
Open 

Backstage 
view to get 

at-a-glance 
information 

about the 
current file, 

access all 
file-related 

commands, 
and modify 

the program 
options.

 

 Select the Open option to open an Excel workbook you’ve worked on of late 
for more editing. When you select Open, Excel displays a panel with a list of all 
the workbook files recently opened in the program. To re-open a particular file 
for editing, all you do is click its filename in this list.

 To close the Backstage view and return to the normal worksheet view, you 
select the Back button at the very top of the menu or simply press Esc on your 
keyboard.

Using the Excel Ribbon
The Ribbon (shown in Figure 1-4) groups the most commonly used options 
needed to perform particular types of Excel tasks.
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Figure 1-4: 
Excel’s 
Ribbon 

consists 
of a series 

of tabs 
containing 
command 

buttons 
arranged 

into differ-
ent groups.

 

To do this, the Ribbon uses the following components:

 ✓ Tabs for each of Excel’s main tasks that bring together and display all 
the commands commonly needed to perform that core task.

 ✓ Groups that organize related command buttons into subtasks normally 
performed as part of the tab’s larger core task.

 ✓ Command buttons within each group that you select to perform a par-
ticular action or to open a gallery from which you can click a particular 
thumbnail. Note: Many command buttons on certain tabs of the Ribbon 
are organized into mini-toolbars with related settings.

 ✓ Dialog Box launcher in the lower-right corner of certain groups that 
opens a dialog box containing a bunch of additional options you can 
select.

 To display more of the Worksheet area in the program window, collapse the 
Ribbon so that only its tabs are displayed by simply clicking the Collapse the 
Ribbon button on the right side above the vertical scroll bar. You can also 
double-click (or double-tap on a touchscreen) any one of the Ribbon’s tabs, 
or press Ctrl+F1 on your keyboard. To once again pin the Ribbon in place so 
that all the command buttons on each of its tabs are always displayed in the 
program window, double-click (or double-tap) any one of the tabs, or press 
Ctrl+F1 a second time. You can also do this by selecting the Pin the Ribbon 
button (whose icon looks just like a pin) that replaces the Unpin the Ribbon 
button and appears whenever you temporarily activate a tab to use its com-
mand buttons.


